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NOTE SUR LE PARAMÉTRAGE DE WINDOWS 
 
Dans toute la suite on suppose que le séparateur de liste est le point-virgule et que le 
séparateur décimal est la virgule.  
 
Dans Windows XP il faut, pour cela, régler les paramètres régionaux : 
Démarrer > Panneau de configuration > Options régionales > Modifier le 
format des nombres > Personnaliser. 
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1. Notions de base 
Documents modèles pour les maths 

Microsoft Word n’est pas un traitement de texte scientifique. Il permet cependant 
d’écrire des textes mathématiques, pourvu qu’ils ne soient pas trop complexes, en 
utilisant l’éditeur d’équations intégré –s’il est installé– ou, mieux, MathType, ou 
encore divers modèles de documents (Amath, Scidot, GDmath, ...). Ces modèles 
fournissent des macros commandes utilisant les champs de Word, en particulier le 
champ EQ. Certains proposent même une police de caractère spéciale (chapeau 
des angles, ensembles de nombres , , , ℂ,…). 

Ce document tente d’apporter quelques indications sur la mise en œuvre de ce 
champ, vestige des premières versions de Word. 

 

Qu’est-ce qu’un champ ? 
Un champ est une formule qui génère un résultat. Ce résultat peut être un 
graphique, un texte, un nombre, une date, une expression mathématique, ... On 
peut ainsi faire afficher la date du jour ou le nombre de pages d’un document. 

 

Insertion d’un champ 
Utiliser le menu Insertion > Champ ou les touches du clavier. 

CTRL F9 génère les délimiteurs de champ { }. Ces accolades n’ont rien à voir avec 
des accolades obtenues au clavier. Elles sont destinées à contenir la formule. 

TAPER entre ces accolades le code du champ par exemple, pour les plus simples, 
Time, Date, FileName... 

Le code dépend de la version de Microsoft Word utilisée (noms en français : {DATE}, 
{NOMFICHIER}, {HEURE} ou en anglais : {Date}, {FileName}, {Time}…). Word ne fait 
pas la distinction entre majuscules et minuscules. 

 
F9 calcule alors le champ : {date} donne la date du jour. 

 

Édition d’un champ 
MAJ F9 est une bascule qui, pour un champ donné, permet de passer du code au 
résultat et inversement.  

Pour éditer un champ, le sélectionner ou placer le point d’insertion sur le champ 
puis presser  MAJ F9, apporter les modifications éventuelles, puis  MAJ F9. 

ATTENTION ! 
Un double-clic sur un champ EQ, le convertit en un objet incorporé « éditeur 
d'équation ». Impossible de changer cet état de choses. En cas de fausse manœuvre, 
annuler par le menu Édition > Annuler ou par CTRL Z. 

 

Des formules aux résultats 
ALT F9 fait basculer tous les champs du document du code aux derniers résultats 
calculés et inversement. 

On passe aussi de l’un à l’autre par  :   
Affiche > Codes de champs (suivant configuration) ou  
Outils > Options > Affichage > Codes de champs . 
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Ergonomie 
Pour un travail fréquent avec les champs, il est utile de mettre l’icône « affiche code 
champs » ({a}) dans une des barres d’outils (Outils > Personnaliser > Commandes > 
Affichage > Afficher les codes de champ ). Le bouton obtenu permet de basculer 
du code au résultat et inversement. 

 

Travail sur les champs d’un document 
Si l’état « Affiche Code de Champ » est actif, on travaille les codes comme des 
textes ordinaires : recherche, remplacement, etc.  

S’il n’est pas actif, on peut travailler sur le résultat des champs mais les 
modifications effectuées sur les résultats ne survivront pas à une mise à jour. Cela 
permet, par exemple, après avoir passé le correcteur orthographique et corrigé 
toutes les fautes, de conserver un texte tel qu’il était avant correction. Ainsi le texte 
« Il faut écrire Pythagore et non {quote Pytagore } » sera corrigé en « Il faut 
écrire Pythagore et non Pythagore » mais apparaîtra comme « Il faut écrire 
Pythagore et non Pytagore » dès la mise à jour des champs. 

 

2. Le champ EQ et ses commutateurs 
Pour commencer : fraction, racine, encadrement 

 Fraction : \f(arg1;arg2) 

Le champ {EQ \f (2;ModifTaux)} génère la fraction 
2

ModifTaux .  

Pour l’obtenir taper CTRL F9, puis, entre les accolades ainsi obtenues, EQ \f 
(2;ModifTaux), sans espace autour du point-virgule) : si on laisse des espaces 
entre les paramètres ils apparaissent dans la formule finale. 

 

\f(arg1;arg2) est une instruction. Elle est ici composée du commutateur \f et de 
deux arguments ou paramètres arg1 et arg2 (respectivement le numérateur et le 
dénominateur de la fraction). Les deux arguments sont placés entre parenthèses et 
séparés par un point-virgule (séparateur de liste) ou une virgule suivant la version 
ou la configuration.  

Chaque caractère ou chaque résultat de l’application d’un commutateur est contenu dans 
une « boîte de caractère » invisible. On a essayé ici de colorier cette boîte. Par ailleurs, 
dans certains cas, on a représenté la ligne d’écriture par _______.  

 

{EQ \f(2;\f(a;b))}  donne ____
2
a
b

____ 

Le trait de fraction principal est trop court. Remède possible : ajouter de part et 
d’autre du 2 des espaces insécables. Par ailleurs le trait de fraction principal n’est 
pas sur la ligne d’écriture (voir plus loin le commutateur permettant ce traitement). 

{EQ \f(  2  ;\f(a;b))}  donne ____ 
  2  

a
b

____ 

    {EQ \f(f (x);g (x))} donne ____
f (x)
g (x) ____ 

Remarquer la taille des boîtes et le formatage des caractères dans le code. 
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 Radical : \r(arg1;éventuellement arg2) 

Un argument : { EQ \r(3)}  donne ____ 3____ 

Deux arguments : { EQ \r(3;x) } donne ____3
x ____. 

Le 3 est trop gros ; de plus, x, étant une variable, devrait être en italique. Utiliser 
par exemple le menu Format > Caractère pour diminuer la taille dans le code et 
mettre x en italique : 

{ EQ \r(3;x) }  donne  
3

x . 

 

 Bordure : \x(arg) 

Ce code dessine une bordure autour de arg. 

{EQ \x (5,4 cm)}  affiche  ____ 5,4 cm  ___{EQ \x (\f(a;b))} affiche 
a
b  

 
arg peut être le résultat d’un calcul : ici \f(a;b). 
 

Et on peut faire un encadré dans un encadré : 
 

{EQ \x (\f( \x (a); \x (b)))} affiche 
a

b
 ; {EQ \x (\f (f (x);g (x)))} affiche 

f (x)
g (x)  

 

Traitement des caractères réservés 
 On se propose d’encadrer le texte « un ; deux ». 

Le code {eq \x(un ; deux)} génère une erreur car \x n’admet qu’un argument et 
Word interprète « un ; deux » comme deux arguments. 

Tout commutateur utilise quatre caractères particuliers : la barre oblique inverse 
(\), le séparateur de liste (point-virgule ou virgule suivant la configuration) et les 
deux parenthèses. Ces caractères sont dits « réservés ».  

Pour afficher l’un d’eux, on peut essayer de le faire précéder de la barre oblique 
inverse (pratique fréquente en informatique). Mais le code  { eq \x(un\;deux)} 

donne  un;deux  . Problème de boîte. 

On dispose par contre du commutateur de liste : \l(). Ce commutateur utilise un 
nombre quelconque d'éléments pour créer une liste de valeurs. C’est la seule 
méthode pour avoir une liste d'éléments traitée comme un élément unique dans 
d'autres champs EQ.  

Ainsi le code {eq \x(\l(un ; deux))} donne un résultat satisfaisant : un ; deux  

 

 On se propose maintenant d’encadrer le texte « risette :-) » .  

On peut penser taper le code « {EQ \x(risette :-))} » mais Word interprètera mal la 
première parenthèse fermante considérant qu’elle marque la fin de l’instruction. 

On obtient __ risette :-  ) __ 

{eq \x(risette :-\))} donne _______ risette :-)  __ problème de boîte… 

 

avec le commutateur \l : {EQ \x(risette :-\l()))} donne risette :- ) Pas de chance ! 

Mais en signalant par la barre oblique inverse que la première parenthèse fermante 
doit être prise telle qu’elle on obtient un résultat satisfaisant : 

{EQ \x(risette :-\l(\)))} donne risette :-)  

Équipe académique mathématiques  champ_eq.doc 
Bordeaux 4 / 10 09/03/2007 



 

 On se propose d’encadrer la barre oblique inverse seule : 

{eq \x(\)} donne Erreur !. Normal : après toute barre oblique inverse, Word 
attend un nom de commutateur valide. 

{eq \x(\\)} donne \  Ca marche ! 

{eq \x(\l(\))} donne Erreur ! Normal : même raison que ci-dessus. 

 

 On se pr0pose d’encadrer le texte \x 

{eq \x(\\x)} donne \x  (il faut doubler la barre oblique inverse. 

 

 Autres exemples 

{EQ \l(2\;3abc)} donne : 2;3abc  problème de boîte 

{EQ \l(2;3abc)} donne : 2;3abc 

{eq EQ \l(A;B;\f(C;D);\\E;2;\x(3);abc)} donne : A;B;
C
D;\E;2; 3 ;abc  

 

Options d’encadrement 
Les options suivantes combinées avec \x permettent de  tracer une bordure 
respectivement au-dessus (top), au dessous (bottom), à gauche (left), à droite 
(right) de l'élément : \to  \bo \le \ri  

Un commutateur peut être suivi de plusieurs options \x\bo\le\ri (toto). 
 

{ EQ \x \to \bo(toto) }  donne  ____ toto ____. 

{ EQ \x \le \bo(coucou) }  donne  coucou . et 

{ EQ \x \bo \le(coucou) }  donne  coucou  

{ EQ \x (\x(\bo \le(coucou))) }  donne  coucou  

 
On remarquera (voir ci-dessous) que l’application du commutateur \x à un texte agrandit 
la boîte qui contient ce texte. En particulier, dans le dernier exemple, la partie supérieure 
de la boîte, vide, est très importante d’où l’espacement des lignes. 

 

{ EQ \x \le (\x \le (AB)) }  donne  AB  { EQ \x \le (\x \ri (AB))}  donne  AB  

{EQ \x \le (\x\ri(\x\le(\x\ri(AB))))}  donne ____ AB ____ 

 

Superposition, mise en exposant, déplacement 
 Superposition : \o(arg1 ;... ;argn) (over) 

Le commutateur \o a au moins deux arguments ; il superpose les éléments donnés 
comme arguments. 

{EQ \o(=;/)} donne  =/  

{EQ \o (C;,)} donne  C,   (C cédille majuscule) 

{eq \o(⏐;⎯;°)} donne ⏐⎯°   

et {eq \o(⏐⎯;°)} donne⏐⎯°   
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Les boîtes de caractères n’ont pas toutes les mêmes dimensions. Aussi peut-il être 
intéressant de les superposer en les alignant à gauche (align left), au centre (align 
center)ou  à droite (align right) : 

\al  \ac  \ar  

Par exemple, la boîte du triple trait ⎯⎯⎯  est plus large que celle du ° : 

{EQ \o \al (⎯⎯⎯;°)} donne  ⎯⎯⎯°   

{EQ \o \ar (⎯⎯⎯;°)} donne ⎯⎯⎯°  

 

 Exposant ou indice : \s(arg1;arg2;…;argn) 

Place les arguments en position d'exposant ou d'indice. \s en accepte un ou 
plusieurs. S’il y en a plusieurs, les arguments sont empilés et alignés à gauche.  

{eq \s (un;deux;trois)} donne____ 
un
deux
trois

 ____ 

{eq \s (un;deux;trois;quatre)} donne ____

un
deux
trois
quatre

 ____ 

 
Options agissant sur l’espacement des lignes : 

\ain \din  ajoutent n points d'espace respectivement au-dessus  ou au-dessous 
d'une ligne de paragraphe.  

____ligne____précédente____ 

{eq \s\ai18()}____    ____met cette ligne 18 points de plus que la normale au 
dessous de la ligne précédente 

 
Options agissant sur la position en hauteur d’un élément isolé. 

\upn     \don (up ; down) 

Positionne un élément isolé n points respectivement au-dessus ou au-dessous du 
texte adjacent. La valeur par défaut est de 2 points.  

a{eq \s \up5 (exposant)}  donne ____aexposant __ 

a{eq \s \do5 (indice)}____ donne ____aindice ____ 

   T{EQ \s\do5(E)\s\up3(κ)} donne ____TE
κ ____ 

 

 Déplace : \d() 

Détermine l'emplacement du caractère qui suit le champ EQ. Les options ci-
dessous modifient le paramètre \d. Seule la dernière option doit être suivie de 
parenthèses vides. 

\fon  : (forward : trace le caractère n points vers la droite ; \fo9  \fo5).  

\ban  : (backward : trace le caractère n points vers la gauche ; \ba10).  

\li () : (link : trace un trait de soulignement jusqu’au caractère suivant).  
 

début{ EQ \d \fo10 \li() }fin donne : début fin 
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Quelques idées pour écrire un vecteur 
 Vecteur avec une lettre 

On superpose une lettre (u par exemple, éventuellement en italique) et une flèche 
(qui existe en Times, en Arial ou encore d’autres polices : caractère unicode 2192 
par exemple). 

{eq \o (u; →)}  donne u → 
 

La lettre et la flèche sont superposées. Mais il faut placer la flèche plus haut ! 5 
points ? plus ? moins ? On essaye ! 

{eq \o (u; \s \up5(→))}  donne u→ 

 

 Vecteur avec deux lettres 

Il faut une flèche plus longue. À défaut d’en avoir une on la fabrique en mettant 
bout à bout un trait horizontal et une flèche de même épaisseur et de même 
hauteur (voir les caractères unicodes 2013, 2014, 2015 et 2192). 

{eq \o (AB;\s \up7(–→))} donne  AB
—→

  

 
Le trait et la flèche ne sont peut-être pas soudés ! Cela dépend de l’imprimante, de 
la taille de police utilisée ou d’autre chose... 

Pour souder les deux caractères on peut reculer la flèche de 1 point ou avancer le 
trait. Suivant le nombre de points, on obtient une flèche plus ou moins longue. 

{eq \o (AB;\s \up7 (–\d \ba1 (→)))} donne AB
–→

  

 
La flèche est trop à droite ! Pour remédier à ce défaut on peut caler à gauche les 
deux boîtes : 

{eq \o \al (AB;\s \up7 (–\d \ba1 (→)))} donne AB
–→

   

Ouf ! Enfin… on peut faire plus simple. 

 

Autres commutateurs : intégrale, tableau 
 Intégrale : \i(arg1 ;arg2 ;arg3) 

Crée l’intégrale de arg1 à arg2 de arg3. 

arg1 à arg2 sont placés au dessus et au dessous du symbole de l’intégrale. 

{EQ \i (0;p;f (x) dx )} donne ____⌡⌠
0

p
 f (x)dx____ 

 
Quelques options sont disponibles : 

\in : affiche les limites à droite du symbole plutôt qu'au-dessus et au-dessous.  

{EQ \i \in (1;2; f (x) dx)} donne ____⌡⌠1
2 f (x) dx ____ 

Ce n’est pas très joli. Il faudrait que le symbole d’intégration soit plus grand. On 
peut l’agrandir en agrandissant l’espace avec la ligne précédente : 
 

{EQ \i \in (\s\ai15(1);2; f (x) dx) } donne ____ 
⌡
⌠

1

2
 f (x) dx ____ 

 ________________ 
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La ligne d’écriture courante est alors située 15 points de plus que la normale au-
dessous de la précédente. 

En fait, la taille du symbole est fonction de la taille de la boîte contenant le 
troisième argument. Mais on voudrait un symbole plus grand sans changer la taille 
de  f (x) dx. 

Astuce : superposer à la boîte  f (x)dx une boîte contenant une espace insécable 
mise en exposant et une autre mise en indice. 

Avec la boîte contenant le caractère en exposant : 

{eq \i \in (1;2;\o(f (x) dx;\s\up10( )))} donne ____⌡⌠1

2
f (x) dx

 
 ____ 

 
Avec la boîte contenant l’espace en exposant et la boîte contenant celui en indice : 

{eq \i \in (1;2;\o(f (x) dx;\s\do15( );\s\up10( )))} donne ____

⌡
⎮
⌠

1

2
f (x) dx

 

 
 ____ 

 
Et puis on peut jouer : 

{EQ \i \in   

(1;2;\o(\s\do4(\f(1;f (x))) dx;\s\do20( );\s\up10( )))} donne __

⌡
⎮
⎮
⌠

1

2
1

f (x)
 dx

 

 
 __ 

 

\su : sum ; remplace le symbole intégrale par un sigma majuscule. 

{EQ \i \su(i=1;i=5;(i+3)(i+6))} donne  ∑
i=1

i=5

(i+3)(i+6)  

Comme pour l’intégrale, on peut agrandir le symbole sigma et agir sur sa position : 
 

{eq \i \su(i=1;i=5;\o((i+3)(i+6);\s\do6( );\s\up3( ))))} donne  

__ ∑
i=1

i=5

(i+3)(i+6)
 
 ) ___ 

et {eq EQ \i \su(i=1;i=5;\o((i+3)(i+6);\s\up9( )))) } donne ___∑
i=1

i=5

(i+3)(i+6)
 

) __ 

 

 

\pr : product ; remplace le symbole d’intégration par celui du produit (pi 
majuscule).  

{EQ \i \pr (i=1;i=10;(x  – i ))} donne  ∏
i=1

i=10
(x  – i )  

 
\fc\c  : fixed character ; remplace le symbole par un caractère à hauteur fixe 
spécifié par c.  

{EQ \i  \fc \C \in (n;p; )}—donne ____Cn
p ____ 

 
Noter qu’il faut trois paramètres, éventuellement vides, d’où le (n; p; ). On peut aussi 
augmenter la taille du caractère, positionner la formule sur la ligne…. 
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{EQ \s \up5 (\i  \fc \C \in (n;p; ))} donne ____Cn
p ____ 

 

\vc \c  remplace le symbole d’intégration par un caractère à hauteur variable 
spécifié par c.  

{EQ \i \vc \A \in  (n; p; )} donne ____An
 p  ____ 

 

 Tableau : \a(arg1 ;… ;argn)  (array) 

Dispose les arguments en tableau, ligne par ligne. Par exemple les trois premiers 
sont la ligne 1, les trois suivants la ligne 2, etc.  

Par défaut les lignes ont un seul élément (donc le tableau n’a qu’une colonne). 
L’option \con  (column number) fixe le nombre de colonnes. 
 
À l'intérieur des colonnes les éléments peuvent être alignés à gauche (\al align left), 
au centre (\ac  align center), à droite (\ar  align right) 

Par ailleurs, \vsn  (vertival size) ajoute n points d'espacement vertical entre les 
lignes, \hsn (horizontal size) ajoute n points d'espacement horizontal entre les 
colonnes.  

{ EQ \a \al \co2 \vs3 \hs3(Axy;Bxy;A;B)}  donne__________ 
Axy Bxy

A B
 __ 

{EQ \a \ar \co2 \vs6 \hs3(Axy;Bxy;A;B)} donne___
Axy Bxy

A B
____ 

 

 Crochet : \b() (braket) 

Met un élément entre « crochets ». Les parenthèses sont utilisées par défaut.  

Options disponibles : 
 

\lc\c : (left column : trace le crochet gauche à l'aide du caractère spécifié par c.)  
 

\rc\c : (right column : trace le crochet droit à l'aide du caractère spécifié par c.  
 

\bc\c : (both column : trace les deux crochets à l'aide du caractère spécifié par c.  

Si le caractère spécifié est {, [, ( ou <, Word utilise comme crochet droit le caractère 
fermant correspondant. Pour les autres caractères, Word utilise ceux-ci pour les 
deux crochets. 
 

{ EQ \b \bc\{ (\r(3;x)) } donne  ___{ }3
x ____ 

{EQ \b \bc\[ (\a \ar \co2 \vs6 \hs3(Axy;Bxy;A;B))}  donne___ ⎣⎢
⎡

⎦⎥
⎤Axy Bxy

A B
___ 
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3. Compléments 
Repérage des champs dans un texte 

Sauf paramétrage particulier, rien ne distingue à l’écran le résultat d’un champ du 
reste du texte. Mais, si la case Champ avec trame du menu Outils > Options > 
Affichage est positionnée sur Toujours, les résultats des champs apparaissent en 
grisé ; positionnée sur sélection, le grisé n'apparaît qu’au moment où le point 
d’insertion passe sur le  champ.  

Certains champs ne peuvent pas être entrés au clavier et leur modification manuelle 
génère une erreur. C'est le cas par exemple du champ INCORPORER (EMBED) qui ne peut 
être généré qu'à partir du menu Insère > Objet. 

 

Mise à jour des champs 
En principe, les champs ne sont pas mis automatiquement à jour. Le champ 
{HEURE} ({Time}) renvoie l'heure qu'il était au moment de son introduction dans  
le texte.  

Pour mettre à jour un champ, le sélectionner, puis taper la touche  F9 . 

Pour mettre à jour tous les champs d'un document, sélectionner tout le document 
(CTRL A ou CTRL 5 du pavé numérique) puis F9. 

Les champs sont automatiquement remis à jour lors de l'impression si la case Outils > 
Options > Impression > Mettre à jour les champs est cochée. Par défaut cette case n’est 
pas cochée. 

 

Verrouillage 
Si on souhaite que certains champs ne soient pas remis à jour au moment de 
l'impression ou d’une remise à jour de tous les champs du document, il faut 
verrouiller ces champs par CTRL F11. Pour les déverrouiller : CTRL MAJ F11 . 

 

Figer un champ 
Pour remplacer définitivement un champ par sa valeur, le sélectionner puis CTRL 
MAJ F9. Il n'y a pas de recours possible (sauf Edition > Annuler) 

Si le champ {DATE} affiche 20/03/96, la frappe de CTRL MAJ F9 sur ce champ ne 
conserve que 20/03/96 et il n'est plus possible d'actualiser cette date. 
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